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Introduction: Model
Designer (MoD)

Introduction: Model Designer (MoD) 

The Govern Model Designer (MoD) is used in conjunction with the Govern 
Business Entity Designer (BED) to set up custom end-user forms for 
governing your data.

Forms are based on business models and business entities. The initial setup 
of the business models is performed in the Business Entity Designer. This 
includes setting the datasource, creating the business models, adding the 
entities, mapping the attributes and defining their properties, creating links 
between business entities and between datasource tables, and adding 
validation rules. 

In the Govern Model Designer (MoD), you perform the final setup for the end-
user forms. The models you create in this application are the basis of the end-
user forms, such as Govern. In this application, you define the position of the 
parameters on the form and the dividers on the form. In this application you 
can add custom controls and action buttons.

The two applications are synchronized. The business models that you create 
in the Business Entity Designer (BED) are automatically imported into the 
Model Designer. If you want to make modifications to the business models, 
entities, or attributes, it is recommended to use the Business Entity Designer. 
The changes are automatically imported to the Model Designer.

This guide describes how to set up the Model Designer business models, how 
to integrate the Business Entity Designer entities an attributes, and how to 
define the position of the parameters and the dividers. 

The Govern Model Designer Troubleshooting guide provides screen shots of 
the Model Designer business models with their business entities, custom 
controls, action buttons, and key element keys. It can be used as a trouble-
shooting reference. 

Overview
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Model Designer (MoD)
Chapter 1: Getting Started

This chapter provides references for the system requirements, installation 
procedures, and required applications for the Govern Model Designer 4.5. 

System Requirements and Installation

The Model Designer (MoD) is installed by the Govern Deploy EZ. For details 
on the system requirements and installation procedures for the MoD, refer to 
the System Requirements guide.

Prerequisites

Before launching the Model Designer (MoD) and configuring your business 
models, launch the Govern New Administration (GNA) and configure the 
following:

• Authentication Mode
• Datasource Connection Keys

After defining the prerequisites for your deployment, launch the Business 
Entity Designer (BED) and configure your business entities and models as 
described in the Govern Business Entity Designer (BED) guide. After that you 
are ready to run the MoD.

Authentication Mode

You define the authentication mode when you set up your deployment in 
Govern Deploy EZ. According to the type of authentication you are running, 
you need to perform one of the following setups. This has to be done only 
once for all applications. 

• MSAD Authentication: If you are running Microsoft Active Directory 
(MSAD) Authentication, set up your user accounts in Active Directory. 
Then, run the Active Directory and Govern Integration Tool in the Govern 
New Administration (GNA) application.

• Govern Authentication: If you are running Govern authentication, create 
an administrator account for the user, who is running MoD, in the 

Overview
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USR_USRFILE validation table, using the User Maintenance form in 
Govern Admin (GNA).

For full details on authentication, refer to the Govern Deploy EZ guide.

Datasource Connection Keys

Before you can integrate your data with MS Govern applications, you need 
valid connection keys for all the datasources that you will be using. The 
connection key to your primary datasource is generated when you configure 
your deployment. 

You can then run the Connection Key Management utility in the GNA and 
configure connection keys for as many secondary datasources as required. 

For details on setting up a deployment and connection key for your primary 
datasource, refer to the Govern Deploy EZ guide. For details on creating 
connections keys for your secondary datasources, refer to the Govern New 
Administration Application (GNA) guide.

Logging in to Govern MoD

To log in, launch the Model Designer as follows according to the authentication 
mode you are running. 

• Govern: With this Authentication mode, the user needs a Govern user 
name and password and is authenticated against the Govern user table: 
USR_USERFILE.

• Microsoft Active Directory (MSAD): This is the default. It requires prior 
setup to integrate the Active Directory user and group accounts with the 
MS Govern applications. User information is maintained in Active 
Directory and users log in with their Windows user name and password.

Refer to the Govern Deploy EZ and Govern New Administration (GNA) guide 
for more information.

Starting Govern MoD

Launch the Model Designer (MoD). from the Govern program group in the 
Windows Start menu or from a desktop shortcut:

If you are using Govern Authentication:
© 2013 MS Govern Page 3
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Model Designer (MoD)
1. At the login window, enter your assigned Username and Password.

2. Click OK to start the program.

3. Click OK to start the program.

If an incorrect username or password is entered, an error message is 
displayed; 

4. Click OK, and enter the correct information.

If you are running MSAD Authentication, you are automatically logged in with 
your Active Directory user name and password.

If you select None as the authentication mode, there is no log in. However, this 
mode is not recommended.

Note: After three failed attempts to enter the correct login credentials, the 
login screen and application shut down.
Page 4 © 2013 Govern 
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Chapter 2: Govern Model Designer User 
Interface

This chapter provides a brief overview of the Govern Model Designer (MoD) 
user interface (UI). This interface includes the Main Menu, Status Bar, MoD 
Toolbar, MoD Editor, and Property Explorer window. 

Main Menu

The Main Menu of the Govern Model Designer includes the following items:

• File options: New, Open, Save, and Exit
• Icons for New, Open, Save, and Delete actions
• Windows (Show Property Explorer, Show Toolbar) 

The Property Explorer and Toolbar can be hidden in order to provide more 
room for the MoD Editor.These menu items are used to show these 
components after they have been hidden.

• Windows Communication Foundation (WCF).
The WCF option has two menus items: Load Models and Change 
Connection. 

• Language Selection English or French / Anglais or Français: All translated 
data appear in the selected language.

Status Bar

The MoD status bar displays the MoD software version number (A), 
Connection Key Name (B), Operation Status (C), and Windows system 
information (D). 

Overview
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Model Designer (MoD)
Govern MoD Version

The software version number (A) of the Govern Model Designer is displayed 
to the left of the Connection Key Name. 

Connection Key Name

The name of the connection key to your primary datasource is displayed at the 
bottom of the application window (B).

The Connection Key Name comprises the name of the datasource, the 
datasource server name, and the datasource type. The connection key 
provides access to your datasource from Govern applications. It is generated 
by Govern Deploy EZ when you configure your deployment. For details, refer 
to the Govern Deploy EZ guide. 

Operation Status

A message indicating the status of the last operation (C), such as “Model 
saved successfully,” is indicated to the right of the connection key name. The 
green light indicates that the operation was successful. 

Windows System Information

The system time is displayed in the right corner of the application. Beside this, 
the status of the various locks is displayed, such as the Num Lock, the Caps 
Lock, and the Scroll Lock (D).

MoD Business Models Toolbar

The MoD toolbar displays three types of Business Models on the left of the 
interface, as follows:

OF Models

At the top of the toolbar, the OpenForms (OF) Models are displayed. These 
are the business models that have been created in the Govern Model 
Page 6 © 2013 Govern 
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Designer, as described under Creating a New Business Model in the Govern 
Model Designer on page 15. 

To open an OF Model in the MoD Editor:

1. Launch the MoD.

2. Expand the OF Models section in the MoD Toolbar on the left.

3. Right click on the model you want to open.

4. Select Open. 

An alternative way to open an OF Model is:

1. Select File > Open or click the Open icon in the main menu.

2. Select the model code for the OF Model you want to open.

3. Click OK.

Business Models

The middle section of the MoD Toolbar lists the Business Entity Designer 
(BED) business models. These are automatically imported into the Model 
Designer. In order to use a BED model in the Model Designer and eventually a 
user form, you need to load it to the Loaded Business Models section. From 
there, you can open it in the MoD Editor and make the required modifications.

To load a BED business model:

1. Expand the Business Models section in the MoD Toolbar.

2. Select the model you want to load.

3. Click Load. 
© 2013 MS Govern Page 7
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Model Designer (MoD)
Loaded Business Models

You can expand the business models in the Loaded Business Models section 
of the toolbar to display a list of the business entities in each model. Then, 
expand a business entity to view a list of the attributes it includes. 

The Loaded Business Models section:

• Lists the OF business models that are open in the MoD Editor. When you 
open an OF Model in the top section of the toolbar, it is automatically listed 
under Loaded Models.

• Lists the Business Entity Designer (BED) models loaded from the 
Business Models section. 

Once a business model has been loaded to the Loaded Business Models 
section or opened in the MoD Editor, it can be integrated with a new or existing 
MoD business model. 

To integrate a loaded business model:

1. Open a business model from the OF Models section or create a new one.

2. Expand the Loaded Business Models section of the MoD Toolbar.

3. Select a loaded model and, holding down the mouse, drag it into position 
on the MoD Editor.

For details, see Integrating Business Entity Designer Models on page 17.

MoD Toolbar Actions

The MoD Business Models Toolbar has two buttons:

Auto Hide: Select this button to dock the Toolbar on the side of the 
interface and provide more room for the MoD Editor. To return the 
toolbar to its normal position, select this button again.

Close: Select this button to close or hide the Toolbar. To restore or 
display the Toolbar, select Window > Show Toolbar from the main 
menu.
Page 8 © 2013 Govern 
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MoD Editor

The MoD Editor In the center of the Govern Model Designer displays the open 
business models. 

Each model is displayed on a separate divider. Select a divider, at the top of 
the form to bring the model into focus. Each business entity in the model is 
displayed in a separate column. The element keys in each business entity are 
listed in the order they will appear on the end-user form. 

The following screen shot displays three fully loaded MoD business models on 
the MoD Editor. The Property Information model is in focus. Its properties are 
displayed in the Property Explorer window.

Changing the Position of Entities in the MoD Editor

To facilitate the administrative setup, you can change the order of the business 
entities as they are laid out on the MoD Editor. 

To change the position of an entity on the MoD Editor:
© 2013 MS Govern Page 9
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Model Designer (MoD)
1. Launch the Model Designer.

2. Expand the OF Models section of the MoD Toolbar.

3. Right-click on the model that you want to modify and select Open. This 
opens the business model in the MoD Editor.

4. Select the cell title bar of the model in the MoD Editor.

5. Select Position > Cell Sequence in the Properties window.

6. Enter the number corresponding to the column where you want the divider 
to appear.

7. Click Save.

The other dividers on the form are repositioned automatically. 

For example, on the Building Permits form, to change the Activities divider 
from column 2 to 16:

1. Select the Activities column in the Model Designer.

2. Enter 16 for the Position > Cell Sequence parameter.

3. The Multimedia divider will shift from position 16 to 15. The Linked Names 
divider will shift from position 3 to 2. Similarly, all other dividers will shift 
one position to the left.

Note: Changing the position of the entities on the MoD Editor doesn’t change 
the end-user form. To change the position of entities on the end-user 
form, use the Grouping parameters in the Cell Zone section See 
page 34.
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MoD Property Explorer

This section provides a brief overview of the properties by model, entity, and 
element. The properties in the MoD Property Explorer are, by default, sorted 
and displayed by category. You can change the order to alphabetic. For 
detailed descriptions, see Viewing and Defining MoD Properties on page 28. 

Business Model

For a business model the property categories are:

• Checkout: The data required for the Mass Appraisal and Inspection data 
can be checked out and imported to a tablet or other mobile device for 
making modifications in the field. The properties in this section allow the 
data in the business model to be checked out when set to True.

• Datasource: This property displays the name of the Model Designer 
business model. Once the model is saved, this property is read-only.

• Description: This section displays three items, the Model Code (or form 
number), the Short Description, and the Long Description.

• Grouping These properties are used for creating groups within the 
business model. For details, see Grouping on page 31.

• Misc: This section displays the path to the icon used for the end-user form

For details, see Defining MoD Business Model Properties on page 29.

Business Entity

For a business entity, the sections and properties are:

• Datasource: Displays two properties: 
• Current BE: This property displays the name of the business entity 

currently selected in the MoD editor.
• Parent BE: The name of the root entity of the currently selected 

business entity. 
• DB Action Add / Delete / Update: Methods and classes that provide 

instructions for modifying the database. 
• Default Access Rights: Logical Expression to allow adding, deleting or 

updating data.
• Zone Action: In this section, add instructions for viewing.

For details, see Defining MoD Entity Properties on page 34.
© 2013 MS Govern Page 11
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Element Key

For a business entity, the sections and properties are:

• Datasource: Displays the Element Key name.
• defaultaccessrights: Logical expressions to define the access rights.
• Misc: DividerTabSequence (appears for elements assigned to dividers 

with multiple subdividers), the filter settings, and the label text. 
• Filter settings: Optional attribute, filter operator, use negation and label 

text for restricting values.
• Mapping settings: as follows:

• Attribute type: Real (Total Fee, Last fee, Building Permits > BE 
Attribute Type), text, datetime, or int.

Edition mode: Select UI control
• IsLookUp: True (for an element with a query) or False The equivalent 

in the Business Entity Designer is Lookup Value: True or False.
• UI Map ID Code for Control Type: Select the Code to display the UI 

Control type: Displays 2 for Textbox or 12 for Checkbox
• UI Control type: Displays Checkbox or Textbox depending on what is 

selected for the UI Map ID.
• Width / Height: 0 for default or a number in pixels.
• Text Wrapping True or False, according to whether you want the text 

to continue on the next line or on the same horizontal line. 
• Spell Checker True or False, according to whether or not you want to 

use the spell check feature.
• Ignore Columns: If multiple columns are defined for the form, select 

True to have a field span across multiple columns.

For details, see Defining Element Properties on page 44.

Property Explorer Actions

Like the MoD Toolbar, the Property Explorer has two buttons:

Note: In the Business Entity Designer, the equivalent is Data Type 
and be: varchar, bit, datetime, or int

Auto Hide: Select this button to dock the Property Explorer on the 
side of the interface and provide more room for the editor. To return 
the toolbar to its normal position, select this button again.
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Close: Select this button to close or hide the Property Explorer. To 
restore or display the Explorer, select Window > Show Property 
Explorer from the main menu.
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Model Designer (MoD)
Chapter 3: Setting Up Business Models

This chapter describes how to set up a new business model in the Govern 
Model Designer (MoD) and how to integrate business models from the 
Business Entity Designer (BED) into this application. 

The Model Designer business models are the basis of the end-user form. To 
facilitate management of models, it is recommended to use the same name for 
both the Business Entity Designer models and the MoD models. 

The Business Entity Designer (BED) is used for creating models and entities, 
adding attributes, mapping data to the datasource, and adding validation 
rules. The Model Designer (MoD) is used for adding the look and feel and 
setting up the parameters on end-user applications and for setting up the 
parameters on end-user forms.

The chapter provides the prerequisites and the procedures for setting up a 
Model Designer business model and integrating the Business Entity Designer 
business models into this application. It also provides the procedures for 
synchronizing and for deleting MoD business models.

Prerequisites

Before using the MoD, create and configure your business models, entities, 
and attributes in the Govern Business Entity Designer (BED) and establish 
links between your entities and between tables. For detailed procedures and 
descriptions, refer to the Govern Business Entity Designer (BED) guide. 

The Model Designer Business Models

The MoD business models are displayed in user applications as end-user 
forms. They are based on Business Entity Designer (BED) models. In the BED 
application, you create the models, define the business entities that are 
included with each model, define properties and database mappings for the 
attributes with the model, and define the relationships between business 
entities and database tables.

Overview

Note: All Govern Business Entity Designer (BED) prerequisites are 
applicable to the Model Designer.
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This section describes how to set up a new MoD model and integrate 
Business Entity Designer (BED) to it. 

Creating a New Business Model in the Govern 
Model Designer

The first step in creating an end-user form is to create a Business Entity 
Designer (BED) model. This model defines the properties for the form and for 
the parameters included in the form, the datasource mapping, the entities that 
are included, the attributes, the validation rules, and the relationships between 
entities and between datasource tables. Details are provided in the Govern 
Business Entity Designer (BED) guide.

Once you have defined your BED models, you are ready to define your MoD 
models. MoD business models are the basis of end-user forms. The name 
given to the MoD model is displayed on the form. The entities within the model 
are displayed as dividers on the form. The organization of parameters on the 
end-user form and the general look and feel of the form are defined in the 
Govern Model Designer. 

Each Model Designer business model contains a Business Entity Designer 
model. The BED models are displayed in the Model Designer on the MoD 
Toolbar under Business Models.

The next step is to create a MoD business model and to integrate a BED 
model with it. 

To create a new MoD business model:

1. Launch the Govern Model Designer (MoD).

2. Select File > New or click on the New Model icon .
© 2013 MS Govern Page 15
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A New Model divider is added to the MoD Editor.

3. Enter a name for the new model in the Short Description text box in the 
Property Explorer.

4. The text box for the long description is filled automatically with the text 
from the short description. You can expand the definition if required.

5. Enter a code for the new model in the Model Code text box. This is a 
unique combination of alphanumeric characters to identify the model.

6. Follow the instructions for integrating a Business Entity Designer business 
model to the new model. 

7. Select File > Save or click the Save button to add the new model to the 
Open Forms (OF) business models list at the top of the business models 
tree view on the left of the MoD UI.

8. Select the tab for the new model to begin defining the new MoD business 
model.

Note: Before you can save the new model, you need to name it, assign a 
code, and integrate a Business Entity Designer (BED) business 
model to the new MoD model.
Page 16 © 2013 Govern Software Inc.
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Opening a MoD Model

To open an existing Model Designer business model:

1. Launch the Govern Model Designer.

2. Expand the OF Models section 

3. Do one of the following:
• Right click on the applicable MoD Model and click Open to open it in 

the MoD editor.
• Select File > Open or click the Open button and select the model from 

the Model Sector Form.

4. Follow the procedures for defining model properties under Viewing and 
Defining MoD Properties on page 28 or for positioning the parameters and 
dividers under Designing the Form on page 55.

Integrating Business Entity Designer Models

The next step is to add Business Entity Designer (BED) models to the new 
MoD business model.

The business models that you created in the Business Entity Designer are 
listed in the middle section of the MoD under business models. In order to add 
these models to the new MoD business model and use them with the Model 
Designer, you need to load them. 

To integrate BED Models to a new MoD Model:

1. Launch the Govern MoD.

2. Expand the OF Model section in the MoD Toolbar.

3. Create a new OF Model or open an existing one. 

4. Expand the Business Models section of the MoD toolbar.

Note: Models are listed by Model Code.

Note: It is recommended to assign the same name to both the MoD and the 
BED business models. this facilitates the management of business 
models and the creation and maintenance of end-user forms.
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Model Designer (MoD)
5. Select a Business Entity model and click Load . This adds the model 
to the Loaded Business Models section of the MoD Editor.

6. Select the model in the Loaded Business Models section, drag it to the 
MoD Editor, and release the mouse.

7. Select File > Save or the Save button to save your changes to the 
Model. new model to the Open Forms (OF) business models list at the top 
of the business models tree view on the left of the MoD UI.

Once the MoD business model is created, you can define properties for the 
model, entity, and elements. Procedures are described under Viewing and 
Defining MoD Properties on page 28.

Procedures for positioning the attributes or elements on the forms and dividers 
are provided under Designing the Form on page 55.

Synchronizing BED and MoD Models

When you open a business model in the Govern Model Designer (MoD), you 
are notified of any new changes to the business models, entities, and 
attributes made in the Business Entity Designer (BED). The following 
message appears:
Page 18 © 2013 Govern Software Inc.

Final Draft



Click OK on this message box to continue.

Updating a MoD Business Model

In the end-user application, such as Govern, MoD business models are 
represented as forms and MoD business entities are represented as dividers 
on the form. 

Use the Govern Model Designer to: 

• Organize the dividers into groups within the form. 
• Position the dividers on the form.
• Position the parameters on the divider to facilitate user input.

Organizing Dividers into Groups

If you have multiple dividers on a form, you can organize these into groups. 
This will provide a cleaner look and enhance the end-user experience. 

For example, the Building Permits form has a group called Links. This group 
includes all the Linked business entities. 

As illustrated in the following screen shot, when you open the Business 
Permits form, all the dividers in the Linked group — Linked Parcels, Linked 
Departments, Linked Buildings, Linked Permits/Offenses/Workflows, Linked 
Inspections, Linked Hearings, Linked UB Accounts, Linked MB Accounts, 
Linked Project Folio, and Linked ST Accounts — appear as a single divider. 

Note: This message is provided for informational purposes only. The Model 
is automatically updated when you click Save.
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Model Designer (MoD)
When you click on the Links divider, all these entities appear on separate 
dividers.

You can change the order, or position, of the dividers on the form. 

Duplicating a MoD Business Model

Use the following procedure to create a copy of an existing Open Forms (OF) 
Business Model. This can be useful if you want to create a second form that 
uses only certain fields from the original. You could maintain two separate 
forms, one for commercial and one for residential data.

To complete this procedure follow the instructions under:

• Duplicating the OpenForms Model in the Model Designer on page 21
• Adding the New Form to a Profile on page 22
• Synchronizing the New Model and Setting the Security on page 24
• Viewing the New Form on page 24
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Duplicating the OpenForms Model in the Model Designer

The procedure in this section creates a new form by duplicating an existing one. 

To duplicate a form:

1. Launch the MoD.

2. Select the model that you want to duplicate from the OF Models Treeview.

In this example, MA65 (MA - MRA) is selected.

3. Right-click on the Model and select Open to open the OF Model in the 
MoD Editor.

4. Enter a new code for the model in the Model Code text box in the Property 
Explorer.

5. Enter a new short and long description in the Short and Long 
Description fields.

6. Click on the Cell title bar in the MoD Editor.
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7. Enter a new name for the divider in the Cell Title field.

8. Make any other required modifications.

9. Click the Save icon.

Adding the New Form to a Profile

The next step is to add the new form to one or more Profiles, as required. 

To add the new form to a Profile:

1. Launch GNA.

2. Select Setup > OpenForms Configuration > Profile Editor to open the 
Profile Editor.

3. Select the Profile that you want to update in the List of Profiles.

4. Click the Add button to add to select the new model.
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5. Select the new model from Select Object in List and click OK. 
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The new model is added to the Profile and displayed under Linked 
Models.

6. Click Save.

Synchronizing the New Model and Setting the Security

The next step is to Synchronize the new form in order to add it to Govern and 
set the security for the data entry fields on the new form.

Refer to the Govern Security Manager (GSM) guide for details about these 
procedures.

Viewing the New Form

To view and test the new form:

1. Launch Govern.

2. Open the Profile to which you added the new form.

3. Open the new form.

Note: The security settings are not automatically copied from one form to the 
other. You need to set them separately.
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In the example, the new form is called New MRA. Both the New MRA and the 
MA - MRA form that already existed are fully functional. Data could be 
updated on either form.

Deleting a MoD Business Model

The MoD Toolbar displays three types of business models: Open Forms (OF), 
Business Entity Designer (BED), and Loaded. This section provides a 
procedure for deleting the OF Models. These models are created in the MoD 
Designer. You cannot delete the other types of models. The BED models can 
be created and deleted in the Business Entity Designer (BED) only. The 
Loaded business models are there for the duration of the session.

The MoD Toolbar on the left lists three types of Business Models. The top 
section lists the OF Business Models. These are created in the Model 
Designer and used directly in the end-user forms. They can be deleted as 
described in the following procedure.

The middle section lists the Business Models created in the Business Entity 
Designer (BED). These can be created, updated, and deleted in the BED only. 
To use these models in a MoD Model, you need to load them to the Loaded 
Business Models section of the MoD Toolbar. From there, you integrate them 
with Govern Model Designer Business Models. Once a Business Model is 
loaded to the Loaded Business Models section, it is there for the remainder of 
the session. 

Deleting a Business Model from the OF Models Section

To delete a model from the OF Model section: 

1. Launch the Govern Model Designer.

2. Expand the OF Models, at the top of the MoD Toolbar.

3. Right click on the model you are deleting.
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4. Select Remove Model. A confirmation message appears:

5. Click Yes to continue.

The Business Model is removed from the list.

Deleting a Business Entity from the MoD Editor

To delete a Business Entity from the MoD Editor:

1. Open the applicable business model in the MoD editor.
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2. Select the business entity that you want to remove.

3. Click Delete.

4. Click Delete. A confirmation appears. This message indicates that 
dependencies will be deleted.

5. Click Yes to continue.
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Chapter 4: Viewing and Defining MoD 
Properties

In the Govern Model Designer (MoD) properties are defined for the business 
model, the business entity at both the cell and content zone, and the element 
key. All properties can be viewed and set in the Property Explorer window, 
located on the right of the MoD Editor. 

Properties are used to name the business models, entities, and elements in 
the Govern Model Designer. They provide references to the corresponding 
items in the Govern Business Entity Designer (BED). They set the paths for 
the icon and external attributes, define groups of entities, define user 
permissions and restrictions for viewing, creating, updating, and deleting data, 
and set filters for retrieving data.

A brief overview of this window and the general property categories is 
provided under MoD Property Explorer on page 11. This section provides 
details for defining properties are described under the following headings:

• Defining MoD Business Model Properties on page 29
• Defining MoD Entity Properties on page 34
• Defining Element Properties on page 44

Overview
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Model Properties
Defining MoD Business Model Properties
The MoD properties set at the business model level provide a reference for 
the Business Entity Designer (BED) model and define general properties for 
the form. They determine how the dividers are grouped, how the parameters 
on each entity are presented on the end-user forms, and the paths for the icon 
and external keys.

To view or define the properties for the business model:

1. Launch the Model Designer (MoD).

2. Scroll to the MoD Toolbar on the left and expand the OF Models section at 
the top of the toolbar.

3. Scroll to the OF model you want to open.

4. Right-click on it and select Open to display it in the MoD Editor.

5. Open the Property Explorer window if it is not already open.

6. Select the title bar of the business model to view and define the properties 
under the following headings:
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Checkout

Checkout

• Subject to Mass Appraisal Checkout: Select True if the business model 
can be checked out. For example, on the Mass Appraisal Land Information 
business model, select True for this property to allow appraisers to check 
out the land information data and import it to a tablet or other mobile 
device for making modifications in the field.

• Subject to Inspection Checkout: 

When, for example the Mass Appraisal Land Information data are checked 
out, the MA Checked Out option is selected on the General Information form 
for the property.

 

Datasource

This section has one property.

BE model: This field displays the name of the BED business model that is 
integrated with the selected Model Designer (MoD) model. It is read-only. If 
you want to change the BE model name, you can do so in the Business Entity 
Designer (BED) application. 
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Description

The properties in this section define the code, short description, and long 
description for the selected business model.

Model Code: When you create a new MoD business model, you need to 
assign it a form number. This is a unique code that is used for identification in 
several places. For example, if you open business models from the main 
menu, they are listed by code. This code is displayed on the title bar of the 
business model and in the MoD Toolbar on the left. For existing models, this 
field is read-only. Once a model is saved, the code cannot be modified.

Short Description: Enter a short description for the model. This description 
is displayed with the model code on the title bar of the business model in the 
MoD Editor and in the OF Models listing in the MoD Toolbar. You can modify 
this description at any time. However, a short description is required. This field 
cannot be left blank.

Long Description: Enter a long description for the model. This field can be 
used to provide more information on the model.

Grouping

When multiple entities are included on a form, you can divide them into 
groups. This creates a cleaner look and a facilitates user input. A scenario 
describing the procedure for setting up a group of entities is provided on 
page 61.

Grouping: Use the parameters in this section to set up groups of entities for 
displaying on the end-user form.

• Count: Enter the number of groups in the Business Model.
• Groups: Each group is automatically assigned a number. 01, 02, 03 etc.

Click inside the Groups text box and select the ellipsis button  to open 
the Collection Editor window and define the following parameters:
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This window facilitates the management of MoD Model groups. The left 
pane is used for setting the order of the business models on the end-user 
form, for adding new models, and for removing existing ones. When you 
add or remove models, the Count property in the Grouping section 
increases or decreases respectively.
• Add: If you are creating a new group, click Add to enable the fields on 

the right.
• Group Name: Enter the name of group. 
• Label: Enter a label to identify the group on the end-user form.
• Tooltip: Enter an optional brief description of the Model Group to help 

the user when filling out the form. The tooltip appears when the mouse 
is held over the Group Name. 

• Use Divider: Select True to display each business entity within the 
group on a separate divider. Otherwise, select False. 

• OK: Click OK to apply your changes.

Misc

Use the parameters in this section to define paths for the icon and the external 
keys, and to define settings for the timestamp and for creating entries.

Icon: Enter the file name and path for the icon for the Business Model.
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External Pk: Click inside the External Pk text box and select the ellipsis 
button  to open the Collection Editor window for external element keys or 
parameters.

• Add: If you are adding a new key, click Add to enable the fields on the 
right and define the properties.

• Argument: Enter the argument name.
• Exclude: Select True or False.
• Primary Key: Select True if the selected element is a primary key. 

Otherwise, select False.
• Value: Enter the value.
• OK: Click OK to apply your changes.

For example, in permit functions starting with PM09, the KIND key is used for 
retrieving data for the root entity. Each business model has a different value.

Append Without Data: Select True if the Create button for the Root Entity 
in the Model can be activated without data. Otherwise, select False.

Time Stamp: The time stamp is automatically added when you save the 
MoD Business Model. It includes the day, month, year, hour, and minute.
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Defining MoD Entity Properties
Entity properties can be defined for the Content Zone or the Cell Zone, as 
follows: 

1. Launch the Model Designer (MoD).

2. Scroll to the MoD Toolbar on the left and expand the OF Models section at 
the top of the toolbar.

3. Scroll to the OF model with the business entity you want to modify.

4. Right-click on it and select Open from the menu.

5. Open the Property Explorer window if it is not already open 

6. Select the title bar of the business entity cell zone or content zone to view 
and define the properties under the following headings:

Cell Zone Properties

The following Cell Zone Properties can be defined:

Content

Business Entity: Displays the name of the Business Entity to which the cell 
is linked. This field is read-only.

Cell Title: Displays the name of the cell on the end-user form. 

Grouping

To create a group of entities, define the Grouping properties for the business 
model as described under Grouping on page 31. Then, set the following 
properties for each entity in the group:

Group: If groups were set up, select the group for the entity from the drop-
down list.

Use the following properties to set the position of the entities within the group 
on the end-user form using the Row and Cell Sequence parameters.

Row Sequence: Enter the row number of the cell inside the group. 
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Cell Sequence: Enter the column for the cell inside the group. 

For example, as illustrated in the following screen shot, the Linked_ 
Departments business entity is in Row Sequence 1 and Cell Sequence 2.

To change the Linked Departments divider from column 2 to 10:

1. Open the Building Permits model in the MoD Editor.

2. Select Cell (1,2) Linked Departments.

3. Enter 10 for the Grouping > Cell Sequence parameter in the Property 
Explorer window.

The other dividers within the group are repositioned automatically. 

The Linked ST Accounts divider will shift from position 10 to 9. The Linked 
Buildings divider will shift from position 3 to 2. Similarly, all other dividers will 
shift one position to the left.

Row Span: Enter the number of rows that the cell will span or merge. 
Otherwise use the default 0 to indicate no span.

Column Span: Enter a number of columns that the cell will span or merge. 
Otherwise, use the default 0 to indicate no span.

Miscellaneous

Zone Panel Type: Select Grid or Canevas depending on how you want to 
arrange the data. 

Zone View Mode: Select Table, One by One, or Divider.
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The following examples illustrate the different zone panel types and zone view 
modes:

Example 1: Canevas and One by One

The Buildings business entity in the Property Information business model uses 
Canevas and OnebyOne.

Example 2: Grid and Table

The Linked Properties business entity in the Property Information business 
model uses Grid as the Zone Panel Type and Table as the Zone View Mode:

Example 1: Canevas and Divider

The General Information business entity uses Canevas as the Zone Panel 
Type and Divider as the Zone View Mode. 

Note: If you select Divider as the Zone View Mode, you need to configure the 
dividers as described in the following section.
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Dividers: Expand the Dividers section and configure the parameters as 
follows:

• Enter the number of dividers in the Count field.
• Enter a name for each divider.

Column Count: Enter the number of columns to display on each divider in 
the selected entity. The following screen shot shows the Summary divider. All 
dividers in the Building Permits entity have two columns.

Note: The Dividers parameters are displayed only if you select Divider as the 
Zone View Type.
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Key Bindings: Two types of Key Bindings can be configured for the 
business entities Filter and Reposition:

Filter type Key Bindings serve the following purposes:

• For the root entity, it is mandatory to have at least one key binding. This 
forms the link between the data retrieved in a search and the data 
displayed on the form.
For example, the General Information business entity is the root or parent 
entity in the Parcel Information business model. The P_ID is selected as 
the Key ID for this entity. Records are displayed on the form, according to 
the P_ID. The links to the child entities in the form are made according to 
8the relationships specified for the business model in the Business Entity 
Designer (BED). For information on creating relationships between entities 
in a business model, refer to the Govern Business Entity Designer (BED) 
guide.

• Additional Key Bindings can be added to refine the data retrieved. 
For example, Land Information is the root entity in the MA: Land 
Information business model. Three Key Bindings are added to this entity 
P_ID, Year_ID, and Frozen_ID. The P_ID forms the initial link to display 
data on the form. The Year ID and Frozen ID refine the data retrieved to 
display only that matching the selected year and frozen IDs.

Reposition type Key Bindings are used to select the record that is displayed as 
the first record when multiple records are retrieved.
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To configure a Key Binding:

1. Click the ellipsis button beside Key Bindings in the Property Explorer 
and add the following configuration:

2. Select Filter or Reposition from the Action Type drop-down list 
according to the type of Key Binding you are creating.

3. Select the Key ID that you want to use for the key binding from the Key ID 
field; for example, select P_ID.

4. If the name of the Key ID in the drop-down list is different from the Key ID 
displayed in the MoD Editor, enter the name as it appears in the MoD 
Editor in the Column Attribute field: 

5. Click OK.

Order By

The parameters in this section define the sort order for retrieving and 
presenting data on the form. 

Fields: Select the ellipsis button  in the Fields text box to open the Fields 
Collection Editor. 
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Click Add to enable the parameters on the right.

Field:  Enter the name of the element or field to use for retrieving and 
presenting data. For the Building Permits model, the field is the permit number 
or PMKEY_ID.

Order by Descendant:  Select True to retrieve the data in descending 
order so that the most recent data, in this case sorted by Permit ID is 
presented first. Otherwise, select False.

Position

The properties in this group are for organizing the entities in the MoD Editor.

Row Sequence: Enter the row on which you the model to appear in the 
MoD Editor.

Cell Sequence: Enter the column on which you want the cell to appear in 
the MoD Editor.

For example, in the following screen shot, PM_Buildings is positioned in the 
second cell or column and the second row in the MoD Editor.
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Row

Use Divider for Row: Select True to display the cells in the selected row on 
dividers.

UI

Tooltip: Enter a brief description of the Group to help the user when filling out 
the form. The Tool Tip appears when the mouse is held over the Group Name. 

Content Zone Properties

Content Zone Properties are used to define the database actions.

Datasource

Business Entity: Displays the name of the Business Entity to which the cell 
is linked. This field is read-only.

Cell Title: Displays the name of the cell for the form. 
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Database Actions

The following properties can be set for adding data to the database, deleting 
or updating them. To define the properties, click inside the text box and select 
the items from the drop-down list. Properties can be set for modifying the 
database after, before, or on executing the control.

To define the properties, click inside the text box and select the items from the 
drop-down list.

DBAction — Add: For adding to the database, properties can be set after, 
before, or on execution of the control and are grouped under OnAfterAdd, 
OnBeforeAdd, and OnExecuteAdd. The properties are the same for each.

DBAction — Delete: For deleting from the database, properties can be set 
for OnAfterDelete, OnBeforeDelete, and OnExecuteDelete.

DBAction — Update: For updating the database, properties can be set for 
OnAfterUpdate, OnBeforeUpdate, and OnExecuteUpdate.

• Assembly Name: Select an assembly from the drop-down list. 
Assemblies are saved in 

• Class Name: Select from the drop-down list the class where the 
appropriate method is located. The class must implement the interface 
GovernSoftwareIActionClass from UI_OFLoader.dll

• Method Name: Select the method to call when the action is invoked.
• Arguments: Set up mapping between function arguments and attributes.
• Return Property: Select the property name with additional values.
• Special Feature: Select an action button such as Create, Delete, Save, 

DeleteNonGeneric, or None. 
• Activate Force Refresh: Select True to activate the Force Refresh in 

other open form applications. Otherwise, select False.
• Call Without Data: Select True if the control will be called when there is 

no data.
• To be Audited: Select True to activate the audit trail for the control.

Default Access Rights

Select logical expressions for viewing and updating rights from the drop-down 
lists. You can create Logical Expressions and view existing ones n the Logical 
Expression editor in GNA. 
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The following logical expression are selected under defaultaccessrights:

• CanUpdateLogExp: Permit Update Rules
• CanDeleteLogExp: Permit Delete Rules

These logical expressions state that a permit cannot be updated or deleted 
once it is approved.

Zone Actions

The zone action properties are the same as the database action properties. 
They are set before viewing or after changing the zone. To define the 
properties, click inside the text box and select items from the drop-down list.
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Defining Element Properties
To view and define properties for each element, select the element in the MoD 
Editor and open the Property Explorer on the right.

1. Launch the Model Designer (MoD).

2. Scroll to the MoD Toolbar on the left and expand the OF Models section at 
the top of the toolbar.

3. Scroll to the OF model with the business entity that has the entity or 
entities you want to modify.

4. Right-click on it and select Open from the menu.

5. Open the Property Explorer window if it is not already open 

6. Scroll to the applicable entity and element.

7. Select the element.

Datasource 

Element Key: Displays the name of the element. This property is view-only. 
It can be changed in the Business Entity Designer (BED).

Default Access Rights

CanViewLogExp and CanUpdateLogExp: Select logical expressions 
from the drop-down lists for controlling viewing and updating rights. You can 
create new logical expressions for these rights n the Logical Expression editor 
in GNA or use existing ones. Refer to the Govern New Administration (GNA) 
guide for details.

NotUpdatable: Set this property to True to allow modifications to the 
element only when it is created. For example, tax exemptions are applied on 
several values including Real Property and Mass Appraisal values. If an 
exemption changes, multiple values are affected. It can be easier to restrict all 
modifications to an exemption. Users can delete an exemption and create a 
new on if required. 

Set this property to False to allow modifications at any time.
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Miscellaneous

Divider Tab Sequence Number: 

If multiple dividers are defined for a business entity, this property defines the 
divider on which the element is located. For example, the PM_BuildingPermits 
entity in the Building Permits model has three dividers. 

Each element in the divider is assigned a tab sequence number according to 
the divider on which it is positioned, 1, 2, or 3. 

Filter Settings: Use these parameters to set up restrictions on certain 
values.

• Attribute: Name of the attribute
• FilterOperator: None, Equals, Less than, Less than or Equal to, Greater 

than, Greater than or Equal to, Between, Like, In, or IsNull
• Use Negation: Select True to use reverse filter settings; i.e., to hide the 

items that match the criteria. Otherwise, select False.

Note: This property is displayed only if the Zone View Mode property is set to 
Divider for the business model. See Zone View Mode on page 35.
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Label Text: Enter a label to appear beside the field on the form. 

UI Control Mapping

Mapping Settings

Use the properties in this section to define the element or parameter on the 
form.

BE Attribute Type: The BE Attribute Type displays the Data Type defined 
for the attribute in the Business Entity Designer or for the datasource column 
corresponding to the selected element.

The BE Attribute Type can be text:, Boolean, Datetime, Integer, or Real. This 
field is read only. It can be modified in the Business Entity Designer.

Edition Mode: Select UI Control.

Is LookUp: Displays True or False depending on what is set in the BED. 

Lookup values are linked to a predefined query or a User or System Validation 
table. Refer to the Managing Attributes chapter in the Govern Business Entity 
Designer guide for further details.

UI Map ID: The UI Map ID is for selecting the UI Control Type.

Control Type: The following table lists the available control types for each 
attribute type.

Note: If labels are defined in both the Business Entity Designer and Model 
Designer, the one defined for the Model Designer appears on the end-
user form. However, the label written for the MoD does not override 
the label written for the BED. 

BE Attribute Type 
(Data Type)

UI Control Type

Text Textbox, Textblock, Label, Checkbox, Hyperlink

Boolean Checkbox, Combo box, or Radio Button

Datetime Datetime, Textbox, Date Only, Time Only
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To define a UI Control Type, click inside the UI Map ID field and select the UI 
Control Type. 

See page for the procedure on defining a Hyperlink

Width: Enter he width of the field or enter 0 to use the default value.

Height: Enter the height of the field in pixels or enter 0 to use the default 
value.S

Overrides: Use this option to connect an Override checkbox with a field and 
to add an Override checkbox to that field. When the checkbox is selected, the 
connected field becomes enabled.

For example, as shown in the following screen shot, the Observed Condition 
check box is linked to the Depreciation Percentage on the MA - 
Miscellaneous Structures field.

An appraiser who feels that the appraised value of a structure should be 
different from the calculated value can check the Observed Condition check 
box and then modify the amount in the Depreciation Percentage field.

If you would like to add an override right next to the field that it is overriding, or 
to a field that is not yet connected to an override checkbox, use the following 
procedure.

Integer Textbox, Checkbox, Textbox Currency, Textbox Thousand

Real Textbox, Checkbox, Textbox Currency, Textbox Thousand

BE Attribute Type 
(Data Type)

UI Control Type
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This gives the following result:

You can then hide the Observed Condition field or make it read-only. 

For details on hiding fields or changing the security, refer to the Govern 
Security Manager (GSM) guide. 

To connect an Override check box with a field:

1. Launch the MOD.

2. Open the business model with the business entity that you modified in the 
Business Entity Designer.

In this example, this is MA - Misc. Structures. 

3. Select the field that you are connecting to the override.

In this example, this is Depreciation Percentage.

4. Select the element you are using for the Override checkbox from the 
Overrides drop-down list. All elements with the UI Control Type set to 
Checkbox are displayed in this list.

In this example, this is OBSERVED_COND.

5. Click Save.

You can then select the override checkbox beside the Depreciation 
Percentage field.

Text Wrapping: Select True for Notes and Comments or other text fields to 
have the text continue on the next line. If you select False, continuous text 
remains on one line. A scroll bar appears if the text has more characters than 
can fit on a single line. 
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Select False for non-text fields.

Spell Checker: Select True to turn on automatic Spell Checking. You can 
use this setting for Text fields. When it is on, a red line appears under 
misspellings. Select False for non-text fields.

Ignore Columns: This setting is applicable to forms with multiple columns. 
Use it when you have a field that requires more than a single column, such as 
a Notes field that would require two or more columns.

You need to select True for the Ignore Columns property of the field that is 
positioned before the field you want to span across multiple columns on the 
user form.

To have a field span across multiple columns:

1. Look for the field before the one you want to span across more than one 
field.

2. Select the Ignore Columns property to True for this field.

3. Modify the height and width of the column you want to span across 
multiple fields, as required.

This is illustrated in the following series of screen shots. Ignore Columns is 
set to True on the NHBD Adjustment field. The Width of the Notes field is set 
to 600.
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Adding a Hyperlink to an Element

Use the following procedure to add a hyperlink to an element:

The procedure comprises multiple steps:

• Creating a Query that Calls a Hyperlink
• Linking the Query to an Attribute
• Defining User Properties for the Element
• Synchronizing the Model and Setting the Security
• Testing the Hyperlink

Creating a Query that Calls a Hyperlink

The following hyperlink opens Google Maps and zooms in on a parcel, based 
on the current Parcel ID.

To create a query that calls a hyperlink:

1. Launch GNA.
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2. Open the SQL Editor.

3. Enter a query similar to the following in the Query Editor text box:

4. Save the query.

For further details on creating queries, refer to the Govern New Administration 
(GNA) guide.

Linking the Query to an Attribute

Use the following procedure to link the query to an attribute, or parameter. 
When the user clicks on the parameter, in Govern, Google Maps is launched 
and opens to the parcel.

To link an query to a new stand-alone attribute. Make it a calculated field that 
calls a query. LInk the query that created in GNA to that attribute.

To link a query to an attribute:

1. Launch the Business Entity Designer (BED).

SELECT
'http://maps.google.com/maps?q='||
FORMATED_ADDRESS || ' ' || ISNULL(CITY,'') || ' ' ||
ISNULL(ZIP_POSTAL,'')
FROM PC_ADDRESS
WHERE P_ID = Parcel ID
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2. Open the Business Entity to which you want to add the hyperlink.

3. Create a New Attribute.

4. Set the Calculated Value to True in the Property Explorer.

5. Set the Expression Type to Query in the Calculated Field Data 
Settings.

6. Select the query that you created in GNA from the Query Description 
drop-down list.

7.  Click Save.

Defining User Properties for the Element 

The next step is define the Map Settings for the element in the Model 
Designer.

To define the map settings:

1. Launch the Model Designer.
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2. Open the Open Forms model that contains the attribute you mapped to the 
query.

3. Select the element.

4. Modify the label in the Label Text field in the Property Explorer 

5. Change the UI Control Type to Hyperlink.

6. Click Save.

Synchronizing the Model and Setting the Security

Use the following procedure In order to make the model visible in Govern. 
Then set the security for the new element. For details on these procedures, 
refer to the Govern Security Manager (GSM).

Testing the Hyperlink

The next step is to test the hyper link in Govern.

To test the hyperlink:

1. Launch Govern.

2. Open the Profile containing the model to which you added the hyperlink.

3. Open the form and divider with your new element.

4. A tooltip displays the hyperlink path.
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5. Click on the link.

You can use the same procedure to open an external application directly from 
an attribute. 

To open an application from an attribute:

1. Follow the procedure for adding a hyperlink to the element. with the 
following modification:
• When you create the query, enter the path to the application, for 

example:

SELECT 'C:\Program Files\Notepad.exe' FROM
PC_ADDRESS
where p_id = Parcel ID
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Chapter 5: Designing the Form

This chapter describes the procedures for giving the end-user forms their look 
and feel. Procedures include arranging the parameters within the entity and 
arranging entities into groups on the form. 

Procedures for defining the initial setup of the form are described under 
Viewing and Defining MoD Properties on page 28.

Organizing the Parameters on the Form

When you open the MoD Editor, the elements are listed in the order they will 
appear on the end-user form. Using the procedure in this section, you can 
move the elements up or down or even put them on another divider as 
required to facilitate end- user input.

Changing the Position of the Parameters

To modify the position of a parameter on a form:

1. Launch the MoD.

2. Open the corresponding Open Forms (OF) model in the MoD Editor.

3. Scroll to the business entity with the element you want to reposition.

4. Select the icon beside the element you are modifying.

5.Right-click and select Move Up or Move Down from the 
menu. 

6.Click Save.

The modification will be in place the next time you open the user application.

Deleting a Parameter

Although it is possible to delete an element using this menu, it is not 
recommended. It is possible to hide a parameter using the Govern Security 
Manager (GSM). This is described in the Govern Security Manager guide.

Overview
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Changing the Divider of a Parameter

If an entity has multiple dividers, you can change the divider on which any of 
the elements are located.

To change a divider:

1. Launch the MoD.

2. Open the applicable OF Model in the MoD Editor.

3. Modify the value of the DividerTabSequence parameter under Misc in the 
Property Explorer. 

4. Click Save.

For example, the root entity in the Building Permits form, PM_BuildingPermits, 
has three dividers. The Purpose field is located on the first tab, General, by 
default. The following example illustrates how to move it to the second tab. 

To change the divider that the Purpose field is located on:
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1. Open the Building Permits model in the MoD Editor.

2. Select the Purpose element.

3. Select the Misc > DividerTabSequence property in the Property Explorer.

4. Select 2 from the drop-down list.

5. Click Save. 

6. Open Govern to view the change.
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Changing the Position of Dividers on the Form

When a business model has multiple entities, you can organize the entities 
into groups. This facilitates user input and retrieval of information. You can 
modify the position of the dividers on the form at any time:

Changing the Position of Dividers within a Group

The following scenario illustrates how to set up a group of entities.

To change the position of the dividers within a group:

1. Launch the MoD.

2. Open the OF business model for the entity.

3. Select the cell title bar of the business entity.

4. Under Grouping in the Property Explorer, set a new position of the Row 
and Cell Sequence.

The other entities are automatically repositioned.

Changing the Position of Dividers on the Form

To change the position of the dividers on the form:

1. Launch the MoD.

2. Open the OF business model for the entity.

3. Select the cell title bar of the business entity.

4. Under Position in the Property Explorer, set a new position of the Row and 
Cell Sequence.
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Form
Adding Parameters to the Form
Use the procedures in this section to add new action buttons, custom controls, 
and label elements.

Adding a New Action Button

To add a new action button:

1. Launch the Model Designer.

2. Open the OF Business Model.

3. Scroll to the business entity. and select the cell title or cell zone.

4. Right-click and select Add action element.

A new action button is added to the entity.

5. Edit the properties for the action button as described in the following 
procedure. 

6. Click Save,

Modifying an Action Button

To edit the action button properties:

1. Select the action button in the entity.
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2. Modify the following properties:
• default access rights: Select a logical expression to enable the action 

button.
• Misc
• Action Settings: Set the following properties for the action button.
• Assembly Name: Select the assembly from the drop-down list.
• Class Name: Set the class where the appropriate method is located. 

The class must implement the interface GovernSoftwareIActionClass 
from UIOFLoader.dll

• Method Name: Select the method for the action.
• Embedded image: Select an icon from the drop-down list if you are not 

using an external image.
• External image: Select the path to the external image for the action 

button if you are not using an embedded image.
• Tooltip: Enter a tooltip to appear when users hover their mouse over 

the action button.
• Arguments: Define the mapping between the function arguments and 

the attributes.
• Return Property: Enter the property name that contains additional 

return values.
• Special Feature: Select one of the following from the drop-down list: 

None, Create, Delete, Save, or DeleteNonGeneric.
• IsEnabledProperty: Select a property from the drop-down list.
• Visibility Property: Select a property from the drop-down list.
• Activate Force Refresh: Select True or False depending on whether or 

not you want to enable the force refresh in other applications.
• Call Without Data: Select True or False
• Label Text: Overwrite the default label New action with a new label. 
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Scenario: Setting up a
Group of Entities
Scenario: Setting up a Group of Entities
If multiple entities are included on an end-user form, arranging them into 
groups will create a cleaner look, and make it easier for users to enter data. As 
an example, the Building Permits form includes 17 entities — as do all the 
permit and license forms beginning with PM09. 

A number of the entities on the permits and licenses form are built from Linked 
tables. These include: PM_Linked_Parcels, PM_Linked_Departments, 
PM_Linked_Buildings, PM_Linked_Keys, PM_Linked_Inspections_PM, 
PM_Linked_Hearing, PM_Linked_UtilityBilling, PM_Linked_MiscBilling, 
PM_Linked_Folio, PM_Linked_Conditions, PM_Linked_Events, and 
PM_Linked_SelfReportedTax.

On the Building Permits business model, they are grouped together under the 
group name Links: When you open the Building Permits form, these entities 
appear together under the divider Links. When you click on this divider, each 
entity in the group is displayed on a separate divider, as illustrated in the 
following screen shot:
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Defining the Group within the Model

The first step in setting up a group of entities is performed at the business 
model level, as follows:

1. Launch the MoD.

2. Expand the OF Models section in the MoD Toolbar.

3. Right-click on the Building Permits model to open it in the MoD Editor.

4. Open the Property Explorer window if it is not already open.

5. Expand the Grouping category.

6. Enter 1 in the Count Field.

7. Click on the ellipsis button  inside the Groups text to open the 
Collection box.
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Group of Entities
8. The group is automatically assigned a name comprising the business 
entity name and the group number.

9. Overwrite this name.

10. Enter a label.

11. Click OK.

Assigning Properties within the Group

For each entity that is part of the group, you need to assign it the group name 
property and give it a position within the group.

1. Select the title bar of the cell for the business entity in the MoD Editor.

2. Open the Property Explorer window if it is not already open.

3. Expand the Grouping category.
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4. Select the group to which you want to assign the entity.

5. Enter the Row Sequence for the entity, 1 to place it in the top row.

6. Enter the Cell Sequence for the entity. This is the column for the entity 
within the group.

7. Click Save.
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